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ISDN — A Brief Overview

» Allows the transmission of voice, data, video and graphics, at very high speeds, over standard

communication lines
» QOperates at Layer 3 — Network Layer
» Used in Switched and non-switched circuit & packet networks
« |TU-T standard defines number of component parts & functions of ISDN
» ISDN CHANNELS
» ACCESS TYPES
» DEVICES

» PROTOCOLS
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ISDN Conceptual View
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ISDN Interface and Devices
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ISDN Basics

* ISDN Devices
» Terminal Equipment (TE)
» Terminal Adapter (TA)
» Network Termination 1 (NT1)
» Network Termination 2 (NT2)

» Exchange Termination (ET)
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ISDN Architecture
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ISDN Basics

» Types of channels
» Bearer channel (B-channel=64 kb/s) clear pipe for data
» Delta channel (D-channel, 16 kb/s or 64 kb/s) call signaling information:
o who is calling
o type of call
o calling what number
» High-capacity channels (H channels)

o An H channel is a special, high-speed clear channel. H channels, designed primarily for full-motion

color video, are not yet in common use
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General types of Services

Basic Rate Interface (2 B channels + 1 D channel (16 kb/s))
» Composition: 2B+D (16 kbps D-channel) + synchronization and framing = 192 kbps
> Intended to meet the needs of individual users (residences, small offices)

» Most existing two-wire local loops can support this interface

* Primary Rate Interface (30 B channels + 1 D channel (64 kb/s))
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» In U.S.: 23B+D (64 kbps D-channel) = 1.544 Mbps (T1)
» In Europe: 30B+D (64 kbps D-channel) = 2.048 Mbps (E1)
» Users w/ greater capacity requirements (offices w/ a PBX or LAN)

» May also be used to support H-channels (e.g. 3HO+D supplies a 1.544 Mbps interface)



ISDN Services : PRI & BRI

| 2B+D




ISDN Protocol Structure

Data Link LAPD Q.921 Frame Relay

Physical 1.430 Basic Interface + 1.431 Primary Interface

D Channel B and H Channel




ISDN Layer 3 Protocol

User Call Processing Local Exchange
(Terminal) Call Processing




0.931 Frame Format

9 Bits 1

Message Type

Information Elements...
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ISDN Layer 2 Protocol
Link Access Protocol — D Channel (LAPD)

Layer 2 protocol
Almost identical to LAP-B used w/ X.25 (based on HDLC)

Provides unacknowledged information-transfer service (unnumbered frames, error detection to discard

frame but no error control or flow control) and acknowledged information transfer
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LAPD Frame Format

Flag Address Control Data CRC Flag
8 bits 8 bits g8 Or16 Payload 16 or32 bits 8 bits
bits

SAPI — 6 bits

TEI -7 bits

SAPI - Service Access Point Identifier
C/R - Command/Response

EA - Extended Address field

TEl - Terminal Endpoint Identifier

Address Field of LAP-D Frame Format
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LAPD Channel

D-Channel

SAPI=0 TEI=6 Control Signal

SAPI=16 TEI=6 Packet

’_‘ SAPI=0  TEI=9 Control Signal

End-to-end Mode
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Sample Exchange b/w User & Network

User Network
Ul SAPI = 63 TEl =127

v

TEl Identity Request
Ri= 6242 (random number)

UI SAPI = 63 TEl =127

N

TEI Identity Request
Ri= 6242
Ai=64
SABME SAPI=0 TEl =64

v

VA SAPI=0TEI=64

AN

ISAPI =0 TEl =64 N{S) =0 N(R) = 0

-

Q.931 Setup

I SAPI = 0 TEl = 64 N{S) =0 N(R) = 1

~

Q.931 Setup ACK

RRN(R) = 1

A4
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Advantages of ISDN

Digital

» reliable connection

Speed

» faster (192 kbps in BRI, 1.5 Mbps to 2.048 Mbps in PRI)
Fast call setup

» 2 seconds

Bandwidth on Demand

» adding new channels to the bundle of channels
Multiple devices

» phone, fax, PC, videoconferencing system, router, terminal adapter, each with its own sub-

address
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Advantages of ISDN

To network providers

» standards support universality and larger potential market for services, drive down equipment costs
To manufacturers

» larger potential market, economies of scales

» standards decrease risk of obsolescence

To enhanced service providers

» simplified user access
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GL's ISDN Analyzer

ISDN devices

S/T interface U interface

T1/E1: Analyzer

Analog devices:

phone, Fax IlI Rate adaptation



Protocol Standards Supported by
GL's ISDN Analyzer

A
Q.931
Layer 3 Specification
Q.921 (LAPD)
D-Channel Link Layer
1.430 .431
Basic Rate Primary Rate

. BELLNI2 © Q.33
«  DMS -100, DMS -250 © AESS
. SESS

* ANSI-T1.607

. QSIGETS « ETSI 300- 102
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GL's ISDN Analyzer

=
B4 ISDN Protocol Analysis 0.93x - |EI|5|]
File Wiew Capture Statistics Database Call Detail Records  Configure  Help
o] B O] MtEal =e] 18w FiwE o] — |l
Dev [ 15.. ] Su. [ Fram..[  TIME [Relative]| Len| Enar| C/R saPl [ TEL Jcte [ Res [ ME) [ MIRD | oRv | Message Tupe |
W2 23 18 00:00:27 113625 a8 Comman... 0O I Inform... 0O a9 il 161... SETUP -
2 23 19 00:00:27.113000 38 Comman.. 0O Inform... 0 40 70 163... SETUP
2 23 20 00:00:27 125750 38 Comman... 0 0 Inform... 0 41 70 166... SETUP
223 21 00:00:27.1:31000 a8 Comman... 0O i Infom... 0 42 il 168.. SETUP
W2 23 22 00:00:27.136250 a8 Comman... 0O i Infom... 0 43 il 17... SETUP -
| | 3
Card:d TimeSlot=23 Frame=13 at 00:00:27 113625 QK Len=38 -
HDLC Frame Data + FCS
============ [APD Layer ============ =
ZoR = L. 0. Commandi{Uszer). Response(Hetworlk)
SAPI = Qogooo. .
TEI = Qoooooo.
ctl = .. 0 Information
H{S) = 0100111, (39) -
4| | »
Hex Dumnp of the Frame Data
0o 01 4E 8C 08 02 2F 00 05 04 03 90 90 A2 18 03 HI 7 [} K=
A9 83 90 Y0 0B Al 35 30 38 33 30 32 31 31 31 31 @plp 15083021111
7002 91 84 D9 51 FE Rile]
| i
_z% Device # | ? CiR I Frarme Count(Device #) |
z Commar... 102
2 Respons... 92
total 2 Total 1495
Call 10 Call Status Calling Murm Called Mum Call Start Date & Time Call Duration Felease Complete CEI
‘é}'O completed Soganz1111 E001-05-16 17 0% 11 445500 O0O04% 185625 Mormal call cles
‘éﬁ completed Soganz1111 001 -05-16 17 0811 450750 QO04% 182750 Mormal call clez
'@'2 completec A0Z2021111 2007-05-16 17 0&11 467125 [ALURNTHIE 3 I K Marmal call cles
@'3 completec A0E3021111 2007-05-16 17 0811 462500 O000dz 17EETE Marmal call cles
=7 ramtleterd R0EE021111 2001-05-16 170811 4682680 00004 173625

rinrral pall e
3

|C:\Program Fileshal Communications Ir [195 Frames

4
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Protocol Standard

« Layer 2 Protocols - LAPD is parsed according to =10 |
Q921 Save Load Defaulk
* I—ayer 3 PrOtOCOIS inCIUdes - Eﬁelect summary columns to disple=
> Bell NI2 (Bellcore National ISDN-2), ¥ Menu checked options
> AT&T/Lucent switch 4ESS and 5ESS, A Rl
%Netwnrh’User side seleckion
» ETSI 300-102 Vi
Time Format
» QSIG (Q-reference point Signaling System) 7 View Fiter
ETSI ﬁ:lj YWigw Search
> Q93X (ITU implementation Of ISDN ) & ISDN @&TCF‘ iZonneckion Options
ANSI decode F‘erin:u:lin: Trace Saving Options
» Nortel's switch DMS-100/250 [ startup optans
« MLPP (Multi-Level Precedence. and Preemption) ;@Dam i Groups
procedures for — (ISDN ANSI decode, ITU Ey Views Font 2ize —
implementation - Q.955.3 & Facility Information =22 M1 Decade Optins = _|;|
Element - Q.932) €T | _rl_l o 0 | b
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Call Detail Records

Jd |

~iaix]
File Miew Capture 3Statistics Database Call Detail Records  Configure  Help
| ol |_| a:*lOl Awuzg =e Hll"lll'lfl T % #| ARE | GoTo |

Dev Framett TIME [Felative] S&PI | TEl | CTL | P/F | NiS] | NIR] | FUN
2 023 0 00 00:00.000000 47 Fes. 0 0 Inform.. O 15 25

2023 1 000000, 005455 E Co.. D 0 Super.. O 27

2 023 2 00:00:00.01 0703 11 Co. D 0 Inform.. O 55 29

/2 023 3 00:00:00.01 5974 16 Co. D 0 Inform... O 55 41

Card? TimeSlots=0-23 Frame=0 at 00:00:00.000000 QK Len=47
HDOLC Frame Data + FCS

============ LAPD Layer ============ =

CR = ... 1. Respon=se(U=zer). Command(Hetworlk)
SAPI = Qooooo. . (0)

TEI = Qoooooo. (o)

ok "

-

Hex Dump of the Frame Data

P

02 01 20 34 08 02 00 ED 05 04 02 80 90 18 03 A9 4 1 1 @
‘:;1 [ T S o A I . s | [ b ' 20 a7 28 aCc 21 A0 0 2an [ Il ca’}&eCAnNnn I

Call 1D | can status | Calling Murm Called Nurn | Call Start Date & Time Call Duration ||Release Complete Cau.. | 2]
e completed E69TEE1 000 26200651234 2002-04-08 145204 142275 | 00:00:00 285750 Normal call clearing ~ —
=F completed 6697651000 3620051234 2002-04-08 145324 245770 | 00:00:00 285744 Normal call clearing
=7 completed 669751000 2620051234 2002-04-08 145304 295697 | 00:00°00 306890 Normal call clearing
s active 6697651000 26000651034 | D000-04-08 145204 248645 | 00:00:02 469248 Normal call clearing
bl active 669751000 26200651234 2002-04-08 145224 401557 | 00:00°03 416937 300
=7 active 6697651000 2620051234 2002-04-08 145204 491406 | 00:00:03 307088 wo o
‘4_I Call Duration _PI_I

Off-ling Yigwing |C:'|,F‘ru:ugram Files\al Communications |?2III Frames |

4

Call trace defining important call specific parameters such as call ID, status (active or completed),

duration, CRYV, release complete cause etc are displayed
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Filter Frames

Filtering Criteria

— Filter Selection — Frame Length M or Range bin-hd ax
-+i H I 0.93x 5
Real-time Capture Filter B Dol |
- o ¥ Frame Lengthis)
iojx - EroFrames Oy
Save Load Defaul - 0K Frames Only
o Frame Humber(s)
[[:ﬂ o Device Number >
Capture File Options - . - -8 LAPD
Space Delmited Length Lizt to Exclude R .93 Laper 3
n‘] Card & Stream Selection |5 7
%" Capture Filker

El Gui & Protocol Oplions Deactivate |

Ewclude FISU | Exclude LSS0 Clear ALL

—all Selected
;I Layer | Field | Filter % alue
[rata Link, Frame Lenathlz) G
d | i
— Conditions for all zelections
- AND(+ OR % |nclude © Exclude Deactivate Sel Deactivate Al

» Isolate certain specific frames from all frames in real-time as well as offline
» Real-time Filter applies to the frames being captured and is based on the Frame Length

« The frames can also be filtered after completion of capture according to SAPI, TEI, C/R, N (S), N(R), P/F,
Supervisory Function and Type of ISDN Message
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Search Frames

Search features helps users to search for a
particular frame based on specific search
criteria

— Filter Selection

|8 093

- LAPD

(|

=14 Data Link

----- i Frame Lengthlz]
- *‘ Error Frames Only
@3 DK Frames Only
----- i Frame Mumber(z)
L Device Mumber P

- (0.93x Layer 3

— """ for Errored frames only

ki

Activate Deactivate
—All Selected
Layer | Field | Filker % alue
Drata Link Error Frames Only by
1] | ]
— Conditions for all selections
¢ AND & OR ' Include & Exclude Deactivate Sel Dieachvate Al
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Statistics
statisics

« Statistics is an important feature available in
protocol analyzer and can be obtained for all

frames both in real-time as well as offline mode

« Numerous statistics can be obtained to study
the performance of the network based on

protocol fields and different parameters
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Figld M armes

ﬁ Layers

=14 Physical Link

—Device #

Usze Type [zsingle zelection)

ey
Field
@ Ermor Code "
% ?,ta[”;tlj ITe5c — Statiztic: Tupe(z] [calculated, multiple selection] —
ime Starnp
. Frame Count ﬂ
H %ﬁpla’ﬁ Frame Percent
Byte Count
Em CH Buyte Percent ll
-[=[i] Maodifier Function
@ MR .
@ NiS] R ange Lizt
N P
Ny PJF
N SAP |
Em Supervizany Function
@ TEI £ Cumulative % Separate
[+~ .93 Layer 3
& ¥ [addMod | Remove
— Selected Statistic Information
Layer | Field Hame | Uze Type | Statiztic: Tope Femaove Sel
Phuyzical ... Dewvice # Tatal
R emowve All
A | ] Apply
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Applications

« Can be used as independent standalone units as "probes" integrated in a network surveillance

systems

« Triggering, collecting, and filtering for unique subscriber information and relaying such

information to a back end processor

« Collecting Call Detail Records (CDR) information for billing
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THANK YQOU!
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